


Welcome to AudioCD MP3 Studio!

AudioCD MP3 Studio is a new kind of software for creating your own audio CDs. 
What makes this program special is the way it stores and manages your audio files. 
Normally, the large .wav files take up a great deal of space on your hard disk or 
other storage media. AudioCD MP3 Studio uses a special compressed format that 
cuts these space requirements radically. This format normally achieves a 1:4 
compression ratio, reducing the space taken up by audio files to just one quarter of 
the normal size. For example, it enables you to store the data for a 60-minute audio 
CD in just 150 megabytes instead of the usual 600 megabytes! 

But that's not all: AudioCD MP3 Studio also supports the revolutionary MPEG1 
Layer 3 format (normally referred to as MP3), which achieves much higher 
compression ratios with quality that is virtually indistinguishable from ordinary CDs. 
Many musicians now publish public domain music on the Internet in MP3 files that 
can be downloaded quickly with maximum quality. 

AudioCD MP3 Studio is the first program that enables you to write MP3 files directly 
to music CDs so that you can listen to them on ordinary audio CD players. 

Last but definitely not least, PTS MusicCD doesn't make you wait around. It 
performs all its powerful audio processing functions in real time, at the same time as 
writing the data to the CD.



Installation Information



System Requirements

System requirements for this version of AudioCD MP3 Studio: 

· IBM-compatible PC with a P133 or faster processor
· At least 32MB of RAM 
· Windows 95, Windows 98 or Windows NT 4.0 or higher
· A CD recorder
An ordinary CD-ROM drive for reading tracks (optional)



Recorder Options

Options for selecting the CD recorder and setting the parameters for writing CDs. 

Select the appropriate write speed for your recorder in the Write Speed field. You 
can choose values between 1x, 2x and 4x depending on the recorder model (see 
also: Write Speed).

If you activate the Simulation Mode check box the write process will only be 
simulated. This means that the entire write procedure will be executed without 
activating the laser beam, so that no data is actually written to the CD. You can 
select this mode the first time you use the program to make sure everything is 
working and to test modified settings if you experience a large number of write 
errors on your system (see also Simulation Mode).

Activating the Normalize check box switches on the normalization function, which 
automatically amplifies the loudest passage to the maximum peak value and adjusts
all the other passages accordingly, so that all the tracks on the CD have the same 
overall volume level (see also: Normalizing).



Source Drive Options

Options for configuring the source drive with which you read music tracks. If the 
software identifies your drive or its manufacturer automatically the drive designation 
will be displayed in the selection list and you can assume that the program will 
achieve the maximum possible read quality. If the program cannot identify the drive 
UNKNOWN CD-ROM will be displayed in the list. The system then uses a generic 
driver which will usually work well; however, please note that you may occasionally 
experience minor quality impairment when reading some music tracks with this 
driver. 

The Read tracks at Single Speed option forces your CD-ROM drive to read the 
music tracks at single speed. Some CD-ROM drives are only able to extract digital 
audio from music CDs at single speed, and others can produce better quality when 
extracting at this speed. You should try this option if you experience any read 
problems or feel that the audio quality of your extracted tracks could be better.



Track Directory Options

This dialog allows you to define the directory in which AudioCD MP3 Studio stores 
your music files when you read them from CDs. Choose a suitable directory, such as
D:\TRACKS. 

AudioCD MP3 Studio supports a special compressed format that radically reduces 
the space required for storing music tracks. Selecting the Save as: WAV 
compressed (1:4) option reduces the file size by 75% without any audible reduction
in audio quality. In addition to this the compressed .wav files still conform to the 
standard Windows format and can thus be read by most audio applications and 
utilities.



Dialog: ASPI Options

AudioCD MP3 Studio is able to select the ASPI-Interface. In this dialog all avialable 
ASPI-Interface are displayed, so you can choose that what you want.

After changing the ASPI please restart AudioCD MP3 Studio.



Track Properties: File

You can display this dialog box by double-clicking on a music track entry or by 
clicking on the entry with the right mouse key. In addition to checking the track 
properties you can also use this dialog to edit the title and artist information.



Track Properties: Properties

This tab displays technical file information, including the exact duration of the music 
track, the sampling rate and the format. 

The dialog also provides controls for playing the track,. Simply click Play to listen 
and Stop to stop. These functions will play all supported music track formats.



Read Tracks

This function enables you to read tracks from music CDs. Choose an audio CD from
which you wish to extract tracks, insert it in your CD drive and select the Read 
Tracks option in the CD menu to display the contents of the CD. You can then select
tracks to extract by activating the check boxes to the left of the titles. Select all the 
tracks you want to read before continuing to the next step. 

The first time you click each selection box the Track Properties dialog is displayed, 
allowing you to edit the data for the track. It's a good idea to enter the correct title 
and artist information at this point so that the information is always available when 
you work with the tracks later on. You can also redisplay the properties dialog at any
time by double-clicking on the track entry in the list. 

After selecting all the tracks you want, start the read operation by clicking on the 
Read button.

You can also use the Play and Stop buttons to listen to the tracks before reading 
them, which can be helpful if the CD contains tracks you are not familiar with. 
However, please note that you can only listen to tracks with this function if the 
source CD drive is connected to your sound card with an audio cable.



Read Tracks (Progress)

When you have selected all the tracks and clicked Read this dialog is displayed, 
allowing you to make a couple of final choices. 

If you wish, you can specify Single-speed read at this point. This option produces 
radically improved audio quality with some drives. Some other drives ignore this 
command entirely and perform the read operation at maximum speed anyway. 

When you are ready click Read to start or Cancel to quit.



Write CD

Selecting the Write CD option in the CD menu displays this dialog with information 
about the CD recorder and the current write settings. You can change all the settings
before starting the write operation, but any changes you make here only apply for 
the current session. If you want to use the same settings for all write sessions you 
must edit the parameters in the Options menu.

Write simulation mode:
Select this option if you are not sure whether your system is powerful enough to 
perform the operation correctly. For example, MP3 files often cause problems on 
some systems because unpacking this format places a high load on the computer's 
processor. If the simulation completes without errors you can continue and burn the 
data to CD with confidence.

Normalize:
Music tracks from different sources are often recorded at different overall volume 
levels, and if they are played directly after one another from the same disk the 
sudden volume variations do not sound so pleasant. This function automatically 
adjusts the volume of all the tracks with reference to the same maximum level, so 
that all tracks then play at the same overall level (see also: Normalizing).

Write Speed:
It's important to understand that slower write speeds generally produce better audio 
quality. The difference is often not directly audible but real hi-fi fans should take the 
time and trouble to record their music at single speed (1x).    



When you have entered all your settings, start the operation by clicking on the Write
button. 

The progress of the CD write operation is displayed on the bars in the lower section 
of the dialog box. Keep an eye on the Buffer bar – if it frequently drops down 
towards the minimum level it's advisable to reduce the write speed the next time you
record a CD.





Normalizing

Normalizing means adjusting the overall volume of a music track to a standard 
maximum level. Music tracks from different sources are often recorded at different 
levels and the fluctuations from one track to the next can be annoying when they are
played on after another from a single CD. The Normalize function compensates for 
these differences so that all the tracks you write to a CD have the same overall 
volume level. AudioCD MP3 Studio can execute this function in real time, while it is 
recording the music to CD. Simply activate the Normalize check box in the Write 
CD dialog. You can also choose Normalize as the default setting in the recorder 
options.



Write Speed

The write speed index (1x, 2x, 4x) is a number that expresses the speed at which 
the CD is written as a multiple of the play speed of a normal audio CD player. At 
"single speed" (1x) the recorder will take just as long to write the tracks as a CD 
player would take to play it – for example, 60 minutes for 60 minutes of music. At 
quadruple-speed (4x) the recorder will only takes 15 minutes to write the same data 
to a CD. However, at higher speeds the bit error rate also increases, resulting in a 
deterioration of audio quality. If you want the maximum possible audio quality it's 
always best to record at single speed.



Simulation Mode

In simulation mode CD writing is only simulated, i.e. the entire write process is 
performed but the write laser is not activated, so that no data is written to the CD. 
This mode enables you to test your system configuration and localize errors without 
unnecessarily producing unusable CDs. 



Keyboard Shortcuts

Shortcut Function
<INS> Add track or tracks to project list
<DEL> Remove selected track from project list
<ALT>+ Move selected track up in project list
<ALT>+ Move selected track down in project list 



Format (music data)

Digitized music can be stored in a wide variety of different formats. Among their 
other differences, the individual formats provide different audio quality, and different 
degrees of compression and flexibility. AudioCD MP3 Studio uses the WAV and MP3
(MPEG1 Layer 3) formats because they are commonly used on Windows systems 
and offer good quality combined with a high level of compression. 



Sampling Rate

Analog signals are converted to digital data by recording a consecutive series of 
"samples" of the analog signal at a fixed frequency or "rate". The number of samples
taken per second is referred to as the "sampling rate". Music CD technology uses a 
standard sampling rate of 44.1kHz, which is 44,100 samples per second. This 
means that all data processed with AudioCD MP3 Studio must be recorded at this 
sampling rate to be compatible with the music CD format. The program will refuse to
accept files recorded at other sampling rates. 



Length

In some places AudioCD MP3 Studio expresses the length of music tracks as 
mm:ss:ff – mm stands for minutes, ss for seconds and ff for "frames", which are the 
smallest addressable units on a music CD. Each frame is 2352 bytes long and thus 
has a duration of exactly 1/75th of a second. 



Buffer

The buffer is a 1-megabyte block of RAM used by the program to compensate for 
fluctuations in the flow of data between the hard disk and the CD being written. For 
example, the buffer can compensate for short hard disk accesses, such as the start 
of another program, so that the flow of data to the CD is not interrupted. This is 
important because interruption of the data flow can cause write errors, making the 
blank CD medium unusable. 



The FILE Menu

File menu commands:

New Create a new project file.
Open Open an existing project file.
Save Save an open project file under its existing name.
Save As Save an open project file under a new name.
Exit Exit PTS MusicCD Studio.



The EDIT Menu

Edit menu commands:

Add Tracks Add a new music track or tracks to the project.
Remove Track Remove the selected track from the project.
Track UP Move the selected track up one place in the project list.
Track DOWN Move the selected track down one place in the project list.



The HELP Menu

The Help menu commands give you access to help and reference information for this 
application:

Help Contents Displays the available list of help topics.
About PTS 
Music CD 
Studio

Shows the version number and other information about the 
program.

News & 
Updates

Starts the online registration module and allows you to order 
news and information on program updates by e-mail.



The NEW Command (File Menu)

Use this command to create a new PTS MusicCD Studio project file. The project file is where 
you store your list of tracks and settings for writing a music CD.

Shortcuts

Toolbar:
Keyboard: CTRL+N



The OPEN Command (File Menu)

Use this command to open an existing project file in a new window. 

To create a new project file select the New command in the File menu.

Shortcuts

Toolbar:
Keyboard: CTRL+O



The OPEN Dialog Box (File Menu)

This Windows dialog box provides a variety of options for specifying the file to be opened. 
For example, you can specify the file type and the directory and drive where it is stored, and 
you can select the file to open from the directory list displayed. For more information on the 
many other powerful features of this dialog please refer to your Windows documentation. 
Filename

Enter a filename or select a file from the directory list. This list will only display files with 
the type extension specified in the File Type field.    

File Type
Select the file type from the drop-down list (.mcd for PTS MusicCD Studio files).

Drive
Select the drive on which PTS MusicCD Studio stored the file you wish to open. This will 
normally be the drive containing your Tracks Directory (see the Options menu), which 
PTS MusicCD Studio opens by default.

Directory
Select the directory in which PTS MusicCD Studio stored the file that you wish to open. 
Again, this will normally be the drive containing your Tracks Directory (see the Options 
menu) which PTS MusicCD Studio opens by default.



The SAVE Command (File Menu)

Use this command to save changes to the current project file without changing its name or 
directory location. The first time you select this command to save a new project file PTS 
MusicCD Studio automatically opens the Save As dialog box so that you can give a name to 
the unnamed file. Use Save As to save an existing project file under a different name or in a 
different directory.

Shortcuts

Toolbar:
Keyboard: CTRL+S



The SAVE AS Command (File Menu)

Use this command to save the current document under a different name or in a different 
location. PTS MusicCD Studio also displays the Save As dialog box automatically when you 
save a file that does not yet have a name.

To save changes to an existing file without changing its name use the Save command.



The SAVE AS Dialog Box (File Menu)

The options in this Windows dialog enable you to give the file a name and specify the 
location where you wish to save it. You can use it to change the name of an existing project 
file and/or to save it in a different location. For more information on the many other powerful
features of this dialog please refer to your Windows documentation.
Filename

Enter a new name in this field if you want to save an existing file under a different name.
PTS MusicCD Studio automatically adds the appropriate extension for the file type 
selected in the File Type field.

Drive
Select the drive on which you wish to store the file. This will normally be the drive 
containing your Tracks Directory (see the Options menu), which PTS MusicCD Studio 
opens by default.

Directory
Select the directory in which you wish to store the file. Again, this will normally be the 
drive containing your Tracks Directory (see the Options menu) which PTS MusicCD Studio
opens by default.



The 1, 2, 3, 4 Commands (File Menu)

The names of the last four files saved by PTS MusicCD Studio are listed in order at the 
bottom of the File menu. You can re-open them directly by clicking on the filename entry in 
the menu or by typing the number of the entry. 



The EXIT Command (File Menu)

This command exits the program, terminating your session with PTS MusicCD Studio. 
Alternatively, you can also exit the program by selecting the Close button at the right hand 
end of the title bar or by selecting the Close command in the control menu (opened by 
clicking the application icon at the top left corner of the application window). If you have not 
saved your file PTS MusicCD Studio will prompt you to do so before closing.

Shortcuts
Mouse: Click on the Close button in the title bar (top right).

Double-click on the application icon in the title bar (top left).

Keyboard: ALT+F4



The REMOVE TRACK Command (Edit Menu)

This command removes the selected music track from the project list. If no track is selected 
the menu command displayed greyed out in the drop-down menu and cannot be selected. 

Shortcuts

Toolbar:
Keyboard: DEL



The ADD TRACKS Command (Edit Menu)

Use this command to add new tracks to your project.

Shortcuts

Toolbar:
Keyboard: INS



The Toolbar

The toolbar is the horizontal bar displayed directly beneath the menu bar in the application 
window. The buttons in the toolbar enable you to immediately execute many PTS MusicCD 
Studio functions simply by clicking with the mouse.

Button Function

Create a new project.

Open an existing project file. PTS MusicCD Studio displays the Windows File Open 
dialog box with which you can locate and open your project file.

Save the current project file under its present name. If the project has not yet been 
given a name PTS MusicCD Studio automatically opens the Save As dialog box.

Remove the selected track from the project list.

Add a new track to the project list.



The Status Bar

The status bar is is the bar displayed at the bottom of the application window of PTS 
MusicCD Studio. 

When you move through menu bars with the mouse or cursor keys brief texts explaining the 
highlighted functions are displayed at the left of the status bar. Similar texts are also 
displayed here for the buttons in the toolbar when you hold the mouse pointer over them. 
On some systems you must also press and hold down the mouse button to display the 
toolbar button texts. If you do not wish to perform the button function after reading the text 
simply move the mouse pointer off the toolbar before releasing the mouse button. 

The two fields at the right hand end of the status bar show the total duration of the current 
CD project (i.e. the total length of all the tracks in the list) and the number of tracks in the 
project. 



The HELP CONTENTS Command (Help Menu)

Selecting this command activates the help system and displays the help contents screen, 
which provides direct access to a variety of reference information and detailed instructions 
on using PTS MusicCD Studio.

When you have opened a Help topic you can always return directly to the contents screen by
clicking the Contents button.



The HOW TO USE HELP Command (Help Menu)

Displays information explaining how to use the features of the Help system. 



The ABOUT Command (Help Menu)

This command displays a copyright message an information on the version number of your 
copy of PTS MusicCD Studio.



The CONTEXT HELP Command 

Use the Context Help command to obtain information on specific features of PTS MusicCD 
Studio. When you select the Context Help button in the toolbar the mouse pointer changes 
to an arrow with a question mark. Clicking anywhere in the PTS MusicCD Studio application 
window, for example on a button in the toolbar, will then display the help topic for that 
element or feature. 

Shortcut
Keyboard: SHIFT+F1



Scroll Bars

If the contents of the project list extend beyond the borders of the application window "scroll
bars" are displayed along the right and lower sides of the window.The scroll boxs in scroll 
bars indicate the relative vertical and horizontal position of the displayed window contents. 
You can move the window contents by clicking on the scroll bars and dragging the scroll 
boxes with the mouse. For further details on using scroll bars please refer to the Windows 
documentation. 



The SIZE Command (Control Menu)

In addition to resizing the application window by dragging its edges you can also use the 
Size command in the control menu, which is opened by clicking on the application icon at 
the left corner of the title bar. When you select this command the mouse turns into a four-
headed arrow, and you can then adjust the size of the application window with the CURSOR 
KEYS.

When the mouse pointer is displayed as a four-headed arrow:
1. Press one of the CURSOR KEYS (, ,    and ) to move the pointer to the window edge you wish

to move. 
2. Press the CURSOR KEY again repeatedly to move the window frame. 
3. When you are satisfied with the new window size press ENTER complete the operation. 

Note: This command is not available when the window is maximized. 

Shortcut
Mouse: Drag the window by its edges or the resize handle in the lower right corner. 



The MOVE Command (Control Menu)

In addition to moving the application window by dragging it with the title bar you can also 
use the Move command in the control menu, which is opened by clicking on the application 
icon at the left corner of the title bar. When you select this command the mouse turns into a 
four-headed arrow, and you can then adjust the position of the application window precisely 
with the CURSOR KEYS. When you are satisfied with the new position press ENTER to complete 
the operation.

Note: This command is not available when the window is maximized.



The MINIMIZE Command (Control Menu)

In addition to the Minimize button at the right corner of the title bar you can also minimize 
the PTS MusicCD Studio window with the Minimize command in the control menu, which is 
opened by clicking on the application icon at the left corner of the title bar.

Shortcut

Mouse: Click on the Minimize button in the title bar .



The MAXIMIZE Command (Control Menu)

In addition to the Maximize button at the right hand end of the title bar you can also 
maximize the PTS MusicCD Studio window with the Maximize command in the control 
menu, which is opened by clicking on the application icon at the left corner of the title bar. 

Shortcut

Mouse: Click on the Maximize button at the right hand end of the title bar , or 
double-click in the title bar.



The CLOSE Command (Control Menu)

In addition to the Exit command in the File menu and the Close button in the title bar you 
can also close PTS MusicCD Studio with the Close command in the control menu, which is 
opened by clicking on the application icon at the left corner of the title bar. 

Double-clicking on the application icon has the same effect as clicking once and then 
selecting Close.

 



The RESTORE Command (Control Menu)

In addition to the Restore button in the title bar you can also restore the application window
to its previous size with the Restore command in the control menu, which is opened by 
clicking on the application icon at the left corner of the title bar. Both the Restore button 
and the Restore command restore the window to the dimensions it had before you used 
Maximize or Minimize commands. 



The CD Menu

CD menu commands:

Read Tracks Reads tracks from a music CD.
Write CD Writes the tracks in the current project to a blank CD.



The MOVE TRACK UP Command (Edit Menu)

Moves the selected track up in the project list.

Shortcut
Keyboard: ALT-UP



The MOVE TRACK DOWN Command (Edit Menu)

Moves the selected track down in the project list. 

Shortcut
Keyboard: ALT-DOWN




